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はじめに
前編では、Plane Makerを使って艦上攻撃機 `流星`のフライトモデルを作りました。ただ

し Plane Makerでは 3D 編集機能が弱く、細部を実機に近い形にする事が出来ません。後

編では Blender によって機体形状を作りこみます。

なるべく作成画面の画像を載せ分かり易く解説したつもりです。それら画面の設定は、

最終モデルで修正が入る場合があるのでご了解ください。

この資料を使って、多くの人が機体作成に興味を持っていただければ幸いです。また内

容に誤りがあればご指摘よろしくお願いします。    

なお、この資料は以下のアプリを使用しています。
・X-Plane 11.4 (64 bit) 
・Plane Maker 11.4  英語表示

・Blender 2.79
・XPlane2Blender 3.5　(Blender にアドオン要)
・Gimp 2.10
これらのアプリの使い方詳細については、この資料では述べません。
          

         

     

              

              

1.  機体作成概要

1.1  機体パッケージのファイル構成
機体作成の最終ゴールは X-Plane 11 フォルダの Airplane フォルダ内に機体パッケージ

フォルダ（今回の場合 B7A_Ryusei）を作る事です。機体パッケージフォルダは以下様な
基本構成となります。

B7A_Ryusei /        ……………..…………　流星のパッケージフォルダ

     ├ cockpit_3d /    ……………………….   3D コックピットのテクスチャを収納

     │　　└ -PANELS- 
     │　　　　　　└ Panel_Fighter.png      Fighter の場合の計器表示/操作部テクスチャ

     ├ objects / 　  ………………………..  　.obj や.png ファイル等を収納するフォルダ

     ├ weapons /    ………………………….   weapon ファイル(.wpn .obj .png)を収納

     ├ B7A_Ryusei.acf    …………………....   機体データファイル

     ├ B7A_Ryusei_cockpit.obj   …………..   コックピットオブジェクト

     ├ B7A_Ryusei_cockpit_texture.png   ….   コックピットオブジェクト用テクスチャ

     ├ B7A_Ryusei_icon11.png   …………..    機体アイコン画像( 前編 4.9 項(2) 参照)
     └ B7A_Ryusei_icon11_thumb.png   …..    機体アイコン画像( 前編 4.9 項(2) 参照)   

各フォルダ/ファイルの役割は次の通りです。

(1) cockpit_3d /
このフォルダの下の -PANELS- フォルダには、3D コックピットのテクスチャファイ

ル(今回の例では Panel_Fighter.png)を収納します。なお、3D コックピットから 2D
コックピットに変換する機能が Plane Maker に備わっています(前編の 4.1 項)から、そ

れを使えば 2D コックピットの表示設定でも使えます。

上記テクスチャは Plane Maker で計器を配置するベースになるものです。このテクス

チャは下記(5)の B7A_Ryusei_cockpit_texture.png と同じ内容である事が多いです。作

り方は 3.6 項を参照下さい。

このテクスチャファイルの名称(Panel_xxx.png)は、対象機体のコックピットタイプに

より決められています。コックピットタイプは Plane Maker の Standard → Viewpoint 
→ General タブ画面の Cockpit 欄で指定したものです。表 1.1 に従って画像名称を指
定します。
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表      1.1      コックピットタイプに対応するテクスチャ名称          

コックピットタイプ テクスチャファイル名称

General Aviation Panel_General.png
Airliner Panel_Airliner.png
Fighter Panel_Fighter.png 
Glider Panel_Glider.png 
Helicopter Panel_Helo.png 
Autogyro Panel_Autogyro.png 
General IFR Panel_General_IFR.png
Gyro Twin Panel_Autogyro_Twin
Fighter IFR Panel_Fighter_IFR.png

(2) objects フォルダ
このフォルダには、機体各部をX-Planeに表示する為のオブジェクトファイル(この
資料では略してOBJと呼びます)、及びそのテクスチャファイルを収納します。
OBJ とそのテクスチャファイルは、ファイルパスの記載を簡略化するため同じ場所に
置いています。これらテクスチャファイルは以下の条件が必要です。

OBJ は Blender で作成された機体データから変換(export)して作成されます。その方法

は 9.1 項を参照して下さい。

テクスチャファイルの詳細は 8 項参照。

(3) weapons フォルダ
飛行中に機体から離れて動くオブジェクト、Weaponのファイル(.wpn .obj .png)を収
納します。Weaponの作り方は前編の5項およびこの資料の2.1項参照。            

(4) B7A_Ryusei.acf 
Plane Maker を使って前編で作成した機体のデータファイルです。B7A_Ryusei は機体

を区別する名称です。このファイルは前記 OBJ を X-Plane 上に表示し飛行させます。

このファイルの作成は 9.3 項を参照して下さい。

(5) B7A_Ryusei_cockpit.obj
このファイルは、コックピット内の計器表示やマウス操作する部品等を定義する OBJ
です。この資料では以下コックピットOBJと呼びます。そのファイル名は以下ルール
で付与します。

　　(機体を区別する名称) + _cockpit.obj
(機体を区別する名称) とは機体データファイル(.acf)で使用したファイル名です。コッ

クピット OBJ は必ずしも計器盤の形をしていなくても構いません。計器の表示部のみ、

またはマウスで操作する部品のみのオブジェクトでも OK です。

作り方は 3.6 項参照してください。

このファイルは、X-Plane 11.3 から objects フォルダに収納しても OK となった様です。

 (6) B7A_Ryusei_cockpit_texture.png
前項のコックピット OBJ のテクスチャファイルです。そのファイル名称は以下の
ルールで付与します。

　　(機体を区別する名称) + _cockpit_texture.png
(機体を区別する名称) とは.acf ファイルで使用したファイル名です。

このファイルは(1)のテクスチャファイル(Panel_xxx.png)と同じ画像である事が多いで

す。このファイルは(4)項のコックピット OBJ に貼り付けるテクスチャ画像です。

従ってこのファイルは Plane Maker で配置された計器や、マウス操作する部品の位置
が分かる様に描かれている必要あります。
この画像のファイルサイズは、PC のメモリ消費を少なくする為、極力小さい事が求

められます。作り方は 3.6 項参照して下さい。

このファイルも、X-Plane 11.3 から objects フォルダに収納しても OK となった様です。

(7) B7A_Ryusei_icon11.png 及び B7A_Ryusei_icon11_thumb.png
これらファイルは X-Plane の Flight 設定画面に表示される機体アイコンです。機体

パッケージ作成が完了してから作ります。作り方は前編の 4.9 項(2)を参照して下さい。
ただし、同じサイズの画像を作成して使っても問題ないようです。

1.2  機体作成のながれ
前編ですでに機体のデータファイル(.acf) は作成されているので、これ以降は概ね以下の
手順となります。

(1) X-Plane オブジェクトの構成検討 (2 項参照)
　　　↓
(2) 機体各部の 3D データ作成 (3 項参照)
　　　↓
(3) 必要な部品にアニメーション設定 (4 項参照)
　　　↓
(5) 必要な部品にマニピュレーション設定 (5 項参照)
　　　↓
(6) 全部品に LOD 設定 (6 項参照)
　　　↓

(7) 全部品に Material 設定 (7 項参照)
　　　↓
(8) テクスチャの準備 (8 項参照)
　　　↓

(9) X-Plane オブジェクトに変換 (9.1, 9.2 項参照)
　　　↓
(10) 機体データファイル(.acf)を修正 (9.3 項参照)                           
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2.  OBJ構成
ここで述べる OBJ (X-Plane 用オブジェクトファイル) は、Blender を使って作成した図形

に X-Plane が描画する特性情報を付加したものです。XPlane2Blender を Blender にアドオ

ンすると、最大 20 個まで X-Plane 用レイヤを分ける事ができ、それぞれのレイヤ毎に一

個のテクスチャを割り当て、一個の OBJを作成する事が出来ます(9.1 項)。
それぞれの OBJは Plane Maker により作画方法が指定され、一つの機体用に.acf ファイル

としてまとめられます(9.3 項)。

2.1  OBJ の分け方
Blender で機体モデルを作成する場合は、機体のどの部分を一つの OBJ にまとめるか検

討が必要です。一般的には機体を以下の部分に分けて OBJを作るのが良いと思われます。

しかしながら個別の Material 設定(7 項)が異なればさらに OBJ を分けます。

(1) 機体の外から見える部分

XPlane 11 から機外の反射を表現する Normal Metalness が使えるようになりました。

これを使うためには、テクスチャに normalを追加しその α チャンネルを調整する手
間がかかりますが、見栄えは素晴らしくなりますので、是非使うべきです。

(2) 機内の部分

・Normal Metalness は設定しなくても良い様です。

・太陽光が差し込む部分は Lighting: Outside とします。

・太陽光などで影が出来る場合は shadow mode: Internal only とします。

・X-Plane は通常 Internal 画面で使う事が多いですが、この時は外の景色を作画する

のは無駄になります。この場合は Prefill を指定して、GPU の負担を減らします。

・操縦者が近くで見るので hi res を設定し、テクスチャ画像の解像度で X-Plane は描

画します。hi res を設定しないと X-Plane はテクスチャ画像の半分の解像度で描画し
ます。

(3) 機体外面にある透明部分

他の OBJ を描画した後、最後にこの OBJ を描画する為に Lighting: Glass (Outside) と
指定します。

注　可動風防のガラスの場合は、アニメーションを設定した風防枠を親とし、子部
品に風防ガラスを置きます。風防枠は見えなくても良いので、Material に Draw 
Linked Object: off を設定します。なお同じ形状の風防枠を別 OBJ で見えるように
しておきます。

(4) 機体内部にある透明部分

その部分の奥を正しく描くため Lighting: Glass (Inside) とします。

(5) 計器の表示、マウス操作、カメラ衝突を検出する部分

 これら部分を含む OBJ はコックピット OBJ として決められたファイル名称を付与し

ます(9.2 項)。この OBJ の子供部品(.obj)は以下の物を含む事が出来ます。

・Plane Maker で設定した計器類を表示するオブジェクト

・Camera Collision が設定されたオブジェクト(フリーカメラが通過できない壁)
・マウス操作して Dataref 値を変える事ができるオブジェクト(マニピュレーション設

定されたオブジェクト)

注　コックピット OBJ の全ての子部品(.obj)に LOD を設定出来ません。設定すると描
画されません。

注　このオブジェクトは X-Plane 実行中ずっと CPU が監視してるオブジェウトなの
で、なるべく簡単な構成、少ないテクスチャサイズにするのが良いです。

(6) Weapon 用 OBJ
Weapon 用に OBJ を指定する事が出来ます。

・LOD 設定は出来ません。テクスチャファイル名に#は使えません。その他詳細は

XP11 用機体作成メモ(前編)の 5 項を参照して下さい。

この他、機体分割の都合やテクスチャ画像を分ける都合で OBJ も分ける事があります。
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表   2.1      OBJ      の分類と  その  設定例  

項 OBJ 区分 対象となる部分     

     

　　　　　　　　　　　　　　　　　　　Blender で設定 Plane Maker 設定　(9.3 項参照)                    

      OBJ 毎に設定する 　　　　　　　　　　　部品毎に設定する    機体パック毎に設定する

　　　　Scene プロパティ 　Object プロパティ(6 項参照) 　　Material プロパティ Standard → MISC Objects メニュー

1 主に External 画
面で見る OBJ

機体外表面、稼働
翼、降着装置、アン
テナ支柱、ピトー
管、プロペラ、スピ
ナ、着艦フック

Name: 任意の OBJ名称
Type: Aircraft (Part)
Textures
  Default:
  Night:
  Normal/Specular:
LODs: 4
 Level of detail 1
       Near: 0
       Far:  10
  Level of detail 2
       Near: 10
       Far: 100
 Level of detail 3
       Near: 100
       Far: 1000
  Level of detail 4
       Near: 1000
       Far:   3000     

Manipulator設定不可
☒☒☒LOD:    □

Normal Metalness = On 
Camera Collision = No 
Part Of Cock Panel = No 

Lighting: Outside
shadow mode: Exterior only
use LOD: on
No Prefill
hi-res: off

2 主に Internal 画面
で見る OBJ

操縦席の壁面、計器
盤、操縦装置、シー
ト  

Manipulator設定不可
☒☒LOD:   □ □

または
☒LOD:  □ □ □           

Normal metalness = Off
Camera Collision = No 
Part Of Cock Panel = No

Lighting: Inside
shadow mode: All Views
use LOD: on
Prefill
hi-res: on

3 機体外部の透明
な OBJ

キャノピーの透明部
分

Manipulator設定可
☒☒LOD:   □ □

Lighting: Glass (outside) 
use LOD: on
hi-res: off

4 機体内部の透明
な OBJ

照準器のガラス板 Manipulator設定可       
☒LOD:  □ □ □

Lighting: Glass (Inside)
use LOD: on
hi-res: off 

5 コックピット
OBJ     

X-Plane が表示する計
器がある計器盤、マ
ウスクリックする部
品、Camera collision
を設定する図形 

Name: (機体名) + _cockpit
Type: Cockpit
Textures
  Default: // + (機体名) + _cockpit
  Night:
  Normal/Specular:　　
Cockpit Regions: 1
  Left: 0                                            
  Right: 0
  Width: 10 =1024
  Height: 10 =1024

Manipulator設定可
LOD 指定不可

                            

Normal Metalness = No 
Camera Collision = Yes
Part Of Cock Panel = Yes

Lighting: Outside
shadow mode: Exterior only
use LOD: off 
No Prefill
hi-res: on
Int Cockpit: on

                              

6 Weapon 用 OBJ

      

銃身、爆弾   Name: 任意名称
Type: Aircraft (Part)
Textures
  Default:
  Night:
  Normal/Specular:
LODs: None

Manipulator設定可
LOD 指定不可               

                           

Normal Metalness = Off 
Camera Collision = No 
Part Of Cock Panel = Off 

 Experts → Build Weapons メニュー

画面の Shell Object 欄でファイル名

を設定(前編 5.2.1 項参照)。
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3.  3D 機体データ作成

3.1  Blender 使用前の準備
事前に XPlane2Blender を Blender にアドオンしておく必要があります。XPlane2Blender は
Web検索で入手できます。この資料では XPlane2Blender V3.5 を使って説明しますので、

それ以降であれば問題ないと思われます。このアドオンは Blender に X-Plane 用機体や
シーナリを作成する為の各種メニューが追加されるので必須です。

Blender は以下の様に使用する事を推奨します。

(1) 表示言語はディフォルトの英文のまま使います。

(2) 値の単位はメートルとします。

プロパティ枠の Scene タブ   で▼Scene の Unit
Presets を Meters に設定します。(右図)

(3) 図形の回転中心(Pivot center)は 3Dカーソルとします。

3D View 画面のメニュー(下図)で 3D Cursor　　 を選
択し設定します。これにより回転や拡大縮小の中心

がその時の 3D カーソル位置となります。3D カーソ

ルの座標は▼3D Cursor の Location: (右下図)に示さ

れるので、回転や拡大縮小の際は 3D カーソルの空間
的位置を確認しておく必要あります。

(4) Export Mode は Layers とします。

プロパティ枠の Scene タブ   で▼X-Plane の Export
Mode を Layers に設定します。(右図)
この設定により、作成した図形を X-Plane オブジェク
トに変換する際、表示中のレイヤ内にある図形をまと
めて 1 つの X-Plane オブジェクトに変換されます。機体

のどの部分を 1 つの X-Plane オブジェクトにするかは約

束事があるので 2 項を参照して下さい。

(5) 画面右上の Outliner は、各レイヤの部品をそれぞれ

1 つのの親フォルダにまとめます。

機体作図が進み部品が増えると Outliner 欄に多くの
オブジェクトが記載され、どれがどのレイヤに含ま
れるか分かりにくくなります。その為 Outliner 欄の
記述を以下の様にすることを推奨します。

①各レイヤの原点に Empty Plane Axes　　を追加し、
その名称を以下の例の様に指定します。

　　　#01 Fuselage　　　←X-Plane レイヤ１でそのレイ

ヤの名称が Fuselage の場合

②その子グループに同レイヤ内の全ての部品を移動します(上図)。移動はドラッグア
ンドドロップで行えます。

(6) Outliner 欄の Camera と Lamp は不要なので削除してもかまいません。            
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3.2  機体の配置と三面図設定
Blender 内で作成する機体の位置(向き)は以下の様にしなければなりません。

(1)　実寸で正の Y 軸方向に向かって機体図形を作成する

事。(右図参照)

(2)　Blender の座標原点は Plane Maker で機体を作成した

時の原点に合わせる事 (機体の先端)

以上の条件のもとに以下の要領で、機体の三面図を Blender
の XYZ 座標系に実寸で合わせます。

①機体の全長(L)および全幅(W)をあらかじめ
調べておきます。

②原点上に Y 軸に垂直な Plate を置き,その

Plate をコピーし負の Y 軸方向に全長(L)だ
け移動します。

③原点に X 軸に垂直な Plate を作り、そのコ

ピーを X 軸の正方向に w/2 移動します。作

成した原点の Plate は後で利用しますので消さないで下さい。最終的に上図の様になり
ます。

④画面を Top に変更し(View →
Top)、Background Images 欄
(右図) を使って画面の背景に
平面図を表示させます。

⑤更に機体先端を Blender 座標

系原点の Plate に合わせ、胴

体後端を後端の Plate に合う
様に画像の倍率と位置を調整
します。

同様にして Blender の Left と
Back 画面も、Background 画像
が機体先端と後端に合う様に
の側面図と正面図をそれぞれ
配置します。               

 

3.3  胴体の作成ヒント
基本的には、断面を作りその断面を隣の断面位置

に Exclude し、そこでの断面形状を修正するという
作業になります。

(1) 最初の断面作成

画面を Left にして胴体の目印となる位置をク
リックしカーソルを置きます。
画面を Backにしてカーソルの Location:を
X=0、Y=0 します。

その位置に Circle を作ります。Circle 内の節点

は片側 9 個ぐらいが適当ですが、必要に応じ調

整します。また、オブジェクトに Mirror 設定す
るのであれば片側のみ作成すれば良いです。

(2) 断面を Exclude し形状修正

作られた断面を別の断面位置に Extrude します。別に Left 画面を開いて置き、それ

を見ながら Exclude すると楽です。
その新しい位置で形状をその断面形状に合わせます。
これを断面の数だけ繰り返し胴体を作ります。
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3.4  翼の作成ヒント
(1)  Top 画面で翼の根本部分をクリックし、その位

置にカーソルを置きます。（右図）
Left 画面でカーソル Location の Z 座標値を修
正し、カーソルを翼断面の中央付近に移動しま
す。
その位置に Circle を作成し、を翼型に形状変更
します。
翼型にはフラップやエルロン等の可動翼も記
載します。またそれら可動翼の回転中心点を
含む線も記載するのを忘れない様にします。
後のアニメーション設定で回転中心軸として
使います。
今回のモデルでは右図の様な断面を作成しました。

(2) 根本の断面形状を X 軸方向に Exclude し、
その位置の断面を縮小します翼の弦長を合
わせます。同様な作業を繰り替えし翼オブ
ジェクトを作ります。                   

(3) フィレットを作成する為に。翼の根元の

エッジを選択し Mesh → Snap → Cursor to
Selected をクリックします(下図)。翼の根元
エッジの中央付近にカーソルが移動します。

(4) 例えば ES1.05 とキー入力します。根元エッジが拡大されて面が出来ます。1.05 は拡
大倍率ですが適当な倍率にして構いません。フィレットに置きたい支点の列数だけ
繰り返します。

(5) その形状をフィレットに修正します(上右図)。

                                                                               

                                                                               

       

3.5  主車輪の作成ヒント
(1) 主車輪の回転中心、地上でのタイヤ中心および折り畳み時

のタイヤ中心の 3 点で三角形を作ります。(右図)

(2) Edit 画面でその三角形を選択し、View → Align View →
Align View to Active → Front をクリックし画面をその三角

形を法線方向から見た画面にします(右下図)。
この画面で主輪収納位置のタイヤや主輪カバーを回転し、
主車輪下がっている位置に移動します。この事によりタイ
ヤ緩衝シリンダの最大伸び位置が分かります。
またこの画面から主車輪を収納するアニメーション設定
が可能です。    

(3) 片側の主車輪部品が完成したら、反対側に鏡像複写する

為の面として、原点で X 軸に垂直な Plate (下図、3.2 項で

作ったはず) を作ります。その名称を例えば Mirror Plane
とします。

この Mirror plane は Material 設定で Draw Lincked Objects
(7 項参照)のチックを外してください。そうすればこの平
面にテクスチャ貼る必要ありません。この平面は削除不可。                     

   

    

 

(4) プロパティ枠の Modifiers タブ で Mirror を追

加し、Mirror Object:欄で Mirror Plane を選びま

す(右図)。
この作業をすべての主車輪部品に行います。こ
れで反対側の主車輪が出来ます。

注意：上記方法は固定主輪の場合にのみ有効で
す。主輪にアニメーションを設定する場
合は、右図の Apply ボタンを押下して反対側の主輪のオブジェクトも別に作
る必要あります。                                                     

    注意：アニメーション方法は 4.5.1 項参照。                             
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3.6  計器盤の作成ヒント
以下の手順で作成します。

(1) Plane Maker の 3D コックピットで計器を配置する無地の画像を用意します。今回の場

合は、Panel_Fighter.png の名称で 1.1 項記載の場所に 1024 x 1024 の灰色の画像を準備

しました。画像のサイズは 2 の階乗で正方形でなければなりません。

注　この画像にはマニピュレーション設定(5 項) するオブジェクトのテクスチャも含
まれるので必要最小限の余白が必要です。なるべく小さいほうが良い。       

(2) Plane Maker の Standard → Panel: 3-D メニューから計器設定画面(下図) を開きます。
左の計器リストから必要な計器を画面上にドラッグし貼り付けます。貼付け位置は

適当で構いません。なるべく詰めて貼り付けます。(下図)
全ての計器が設定されたら、その画面をコピーし Gimp の様な画像処理アプリで画像

部を切り出し、画像サイズが 1024 x 1024 になるように拡大または縮小します。

このファイルをコックピットテクスチャ(B7A_Ryusei_cockpit_texture.png) として機体

フォルダの直下に格納します。(1.1 項参照)

                                           

   

(3) コックピットオブジェクト(右図参照) を作成します。このオブジェ

クトは X-Plane 実行中にリアルタイムで画像書き換え、マウス操作
検出、カメラの接触を監視するオブジェクトで以下の部品を含みま
す。
・操縦中の計器状態を表示する子部品
・操縦者がマウス操作する子部品
・Camera collision を設定する子部品(7 項参照)

(4) プロパティ枠の Scene タブ    の▼XPlane で、

Name: は　(機体を区別する名称) + _cockpit.obj　とします。

Type: を Cockpitとします。

Textures には Autodetect Textures のチェックを外し Default 欄にテクスチャ画像の

ルートパスを入力します。Blender ファイルとテクスチャファイルが同じフォルダ内

にある場合は最初に // が入るかと思います。

(5) さらに Cockpits Regions: は 1 に設定して
その画像のサイズを指定します。今回の
例では 1024 x 1024 の画像なので右図の様
になります。

(6) 最後に OBJ に変換し(9.1 項参照)、コク

ピット OBJ として機体パッケージ直下の

フォルダ内に保存します。(1.1 項参照) こ
のコックピット OBJ は以下の注意が必要
です。                               

・このオブジェクトは DOA 設定(6 項)出来

ません。設定すると X-Plane に描画され

ません。X-Plane が混乱する様です。

・機外から見るコックピット OBJと機内で

見るコックピット OBJ は別 OBJに分け

ます。Plane Maker の Misc Objects で Ext
Cockpit および Int Cockpit に設定を分け

ます(9.2 項参照)。ですが今回の例では

Int Cockpitのみ作成しています。

                                        

             

                                                                          9 / 26                                                                                                                

   
  計器リスト



3.7 ランプ設定ヒント                        
ランプは Plane Makerでも取り付ける事が出来ますが、今回の様に折り畳み可能な主翼の

先端に航法灯を付ける場合は、Blender で取り付けます。

Blender によるランプ取付手順

(1) 3D カーソルをランプを取り付ける位置に置きます。

(2) Add→ Lamp メニューをクリックし　　のプロパティにて Type:
を Named に変更します。

(3) Name: 欄には XPlane2Blenderにリストアップ(*) されたランプ名称を入力します。主
なものは以下です。                                                         

ランプ名称 内容

airplane_landing 着陸灯     

airplane_beacon ビーコン

airplane_taxi タクシー用 

airplane_nav_tail   尾灯 

airplane_nav_left 航法灯左

airplane_nav_right  航法灯右 

この他にもシーナリ用も含め色々な Named Lamp が有ります。詳細は X-Plane.org Forum 
の OBJ with All Named Lights  を参照してください。

* 同じものが、io_xplane2blender フォルダ内の lights.txt にリストアップされています。
しかしながらこのファイルは触らない方が良いです。

                                                                               

                                                    

4.  アニメーション設定                  
X-Plane は動作中に指定された場面の値(Dataref 値)をリアルタイムで発行します。

その値を使って機体の指定された部分の表示/非表示(Show/Hide)や、移動/回転

(Transformation)を表示する事が出来ます。

使用できる Dataref は X-Plane - Dataref Search にリストアップされています。

注意：部品が表示/非表示と移動/回転の両方の動作をする場合、その部品を親子に分割

し、親に表示/非表示を設定し、子に移動/回転を設定すること。

4.1  Show / Hide 設定                        
(1) 対象部品を選択し、プロパティ枠

の Object タブ   の▼X-Plane で
Add Dataref ボタンをクリックし，

ます。Dataref 入力欄が現れます。

(2) Dataref Path:欄に使用する Dataref
を入力します。右側の 　アイコ
ンをクリックして、表示されるリ
ストから選択することも出来ます。
アイコン 　を押せばそのリスト
は消えます。

(3) Animation Type:欄で対象部
品を表示させる場合は

Show を、表示させない場

合は Hide をクリックしま
す。

(3) Value 1: に Show 又は Hide
が有効になる開始値を入力
します。
Value 2: に Show 又は Hide
が無効になる終了値を入力
します。

以上の設定で指定された
Dataref 値が Value1 と Value2 の

間にある時、Show の時は対象

部品を表示、Hide の時は非表

示の処理がされます。Show /
Hide アニメーションではキーフレームの設定は必要ありません。

上記画面の例では、対象部品は Internal 画面では表示されなく、External 画面では表示さ
れます。                             
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4.2  Transformation 設定
(1)  オブジェクトモードで対象部品を選択し、画面下部にある

Frame 番号 (Current Frame) 値を 0 に設定します。更に

▼Transform 欄の Rotation:値が全て 0、Scale:値が全て 1 であ

る事を確認します。(右図、重要)
そうでない場合は、Object → Apply → Rotation & Scale メ
ニュー(下図)をクリックしそれまでの修正履歴をリセットし
ます。
それでも Scale:値が 1 でなく-1 の場合があります。その場合

はその部品を鏡像反転し Flip Normals するなどして、1 にな
る様にして下さい。

                                                         

                                                         

 

 

(2) プロパティ枠の Object タブ   の

▼X-Plane で Add Dataref ボタンを

クリックします。Dataref 入力欄が
現れます。

Animation Type:で Transformation
を選択します。

                                  

      

 

 

                                              

             

(3) Blender の 3D View 画面で対象部品をその Frame
番号での位置に回転または移動します。

I キーを押下し現れたリストから LocRot を選

択すると、右図の様に▼Transform 欄の

Location:と Rotation:の値が黄色に変わります。

これでその Frame 番号での部品場所と回転位置
が登録された事が分かります。

Frame 登録を取り消す場合は Alt + I を押下しま
す。

 

(4) Dataref Path:欄に使用する

Dataref を入力します。右側の
アイコン　をクリックして、
表示されるリストから選択す
ることも出来ます。　アイコ
ンを押せばそのリストは消え
ます。

(5)        をクリックして値をリセッ

トしてから Value:欄にその

Frame 番号の時の Dataref 値を
入力し　　をクリックします。
Value:欄が黄色になり、その

Frame 番号 (この場合 Frame 0) 
での Dataref 値が登録されました。

(6) これ以降、Frame 番号 (Current Frame) を次の番号に変更し、(3)項を参照して部品位

置を移動し、(5)項を参照してその状態の Dataref 値を登録します。

参考：アニメーション中に Dataref 値が登録された Value:の範囲を超えた場合は、X-
Plane は外挿法でアニメーション続けますが動作は保証されません。

注意：Transformation は、Dataref 値が 0 である位置を Frame 番号 (Current Frame) の 0
とし、アニメーションを開始します。

注意：親子に分かれた部品は、子部品から（下位の部品から）先にアニメーション設定
するのが良い様です。
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 Frame 番号



注意：回転設定する部品はそのオブジェクトの原点(Origin)を回転中心に置くこと。

注意：回転は 90°ごとに別 Frame にする事。動きがおかしい場合はより細かい角度で

Frame を分けること。

注意：任意方向軸の回転の場合は、軸方向から見た画面で回転させ登録すること。

注意：翼関連の Dataref 記述の最後尾に　...[N] の記載が付く場合があります。これは前

編の 4.3.2 項で設定した翼の部分のどれに関連する Dataref か関連付ける為のもの

です。番号 N は表 4.1 の通り決まっています。

 表      4.1    番号      N  

N  指定場所 10 Vertical stabilizer 1   21 Misc Wing 10

0 Left Wing 1 11 Vertical stabilizer 2 22 Misc Wing 11 

1 Right Wing 1 12 Misc Wing 1 23 Misc Wing 12 

2 Left Wing 2 13 Misc Wing 2 24 Misc Wing 13

3 Right Wing 2 14 Misc Wing 3 25 Misc Wing 14

4 Left Wing 1 15 Misc Wing 4 26 Misc Wing 15 

5 Right Wing 1 16 Misc Wing 5 27 Misc Wing 16 

6 Left Wing 2 17 Misc Wing 6 28 Misc Wing 17 

7 Right Wing 2 18 Misc Wing 7 29 Misc Wing 18 

8 Left horizontal stabilizer 19 Misc Wing 8 30 Misc Wing 19 

9 Right horizontal stabilizer 20 Misc Wing 9 31 Misc Wing 20

4.3 Dataref の選択
以上述べた通り Dataref は、アニメーションされた部品の位置または表示/非表示を決め

る値です。この Dataref は X-Plane - Dataref Search に リストアップされている通り数多

有ります。(同様のものが X-Plane 11/Resources/Plugins/DataRefs.txt にもありますが開かな
い方が良いです） 
古い Dataref はサポートされなくなる可能性が有るので、原則として新規の機体はなるべ

く以下の Dataref を使う事が推奨されています。

　sim/flightmodel2/……
　sim/cockpit2/……..
表 4.2 に今回使用した Dataref をまとめます。

                                                                                                

表      4.2  　アニメーション設定一覧    

項 アニメーション内
容

使用 Dataref

フレーム   Dataref 値: 設定内容 

1 エルロン動作 

                 

左翼エルロン:    sim/flightmodel2/wing/aileron1_deg[2]
右翼エルロン:    sim/flightmodel2/wing/aileron1_deg[3]

Frame 0
Frame 1
Frame 2 

0: 　中央位置
20:   後端が下に 20° 回転
-20:  後端が上に 20° 回転

2 ラダー動作
                                   

sim/flightmodel2/wing/rudder1_deg[10]

Frame 0
Frame 1
Frame 2

0:  　中央位置
20:    上から見て後端が右に 20° 回転
-20:   上から見て後端が左に 20° 回転

3 エレベータ動作 sim/flightmodel2/wing/elevator1_deg[8] 

Frame 0
Frame 1
Frame 2

0:  　中央位置
20:    後端が下に 20° 回転
-20:   後端が上に 20° 回転

4 ジョイスティック
に合わせ操縦桿、
フットペダルを動
かす

左右:    sim/cockpit2/controls/yoke_roll_ratio
前後:    sim/cockpit2/controls/yoke_pitch_ratio
フットペダル:    sim/cockpit2/controls/yoke_heading_ratio

Frame 0
Frame 1
Frame 2          

値   前後　　　　　左右　　　フットペダル
  1:    Full 後方       Full 右      Full 右向き
  0:    中立       　　中立       中立
 -1:    Full 前方       Full 左      Full 左向き

5 フラップ動作

                 

フラップ本体:    sim/flightmodel2/controls/flap1_deg[N]   
操作レバー:    sim/fflightmodel2/controls/flap_handle_deploy_ratio

Frame 0
Frame 1
Frame 2 
Frame 3

0:     フラップ上
10:　10° 下
20:　20° 下
30:　30° 下

6 ジョイスティック
に合わせスロット
ルレバーを動かす 

sim/cockpit2/engine/actuators/throttle_ratio_all 

Frame 0
Frame 1

0: 全閉 (idle)
1: 全開

7

 

抗力板操作レバー
により抗力版を動
かす

抗力版本体:    sim/flightmodel2/wing/speedbrake1_deg[1]               
操作レバー:    sim/cockpit2/controls/speedbrake_ratio 

Frame 0
Frame 1

0: 全閉
1: 全開
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8 主脚軸
リンク 1
リンク 2
ギア扉
タイヤ扉を動かす

右翼主輪:        sim/flightmodel2/gear/deploy_ratio[1]   　　 
左翼主輪:        sim/flightmodel2/gear/deploy_ratio[2]　　　     
操作レバー:    sim/cockpit2/controls/gear_handle_down

Frame 0
Frame 1
Frame 2

 0 :  脚出し完、タイヤ扉閉
0.1: タイヤ扉開
1.0:  脚上げ完

9 主脚出し入れによ
るタイヤ軸の撓み
を 0.2m とし、タイ
ヤ軸とオレオの位
置を設定する。

右翼主輪:    sim/flightmodel2/gear/tire_vertical_deflection_mtr[1] 
左翼主輪:    sim/flightmodel2/gear/tire_vertical_deflection_mtr[2]

Frame 0
Frame 1 

0   : たわみ無し(脚上げ時) 
0.2: たわみ 0.2m (接地時)

10 タイヤ回転 sim/flightmodel2/gear/tire_rotation_angle_deg[0]

Frame 0
Frame 1

0  :    初期値    
90:　機体前進する方向に 90°回転            

11 風防開閉動作に合
わせステップ、
取っ手を動かす  

sim/flightmodel2/misc/canopy_open_ratio

Frame 0
Frame 1
Frame 2

 0 :  全閉
0.1: ｽﾃｯﾌﾟ出
1.0:  全開  

12 エンジンが 20RPM
以下の時プロペラ
を表示する

sim/flightmodel2/engines/prop_rotation_speed_rad_sec[0] 

Frame 0
Frame 1

0～20: Show
20～60000: Hide                                

13 プロペラ回転動作 sim/flightmodel2/engines/prop_rotation_angle_deg[0]

Frame 0
Frame 1 

0  :　初期値  
90:　操縦席から見て右に 90°

14 カウルフラップ開
閉  

sim/cockpit2/engine/actuators/cowl_frap_ratio[0] 

Frame 0
Frame 1

0:  全閉
1:  全開 

15 爆弾層開閉 扉本体：　sim/flightmodel2/misc/custom_slider_ratio[1]
操作レバー:    sim/cockpit2/switches/custom_slider_on[1]

Frame 0
Frame 1

0:  全閉
1:  全開 

16 External 表叔父の時
のみパイロットを
表示する 

視点が機外か検出:    sim/graphics/view/view_is_external

Hide
Show

0 ~ 0.5:  隠す(External view でない)
0.5 ~ 1:  隠さない(External view)

  

4.4 カスタムスライダー
Dataref の中には、ユーザーが部品をクリックし部品のアニメー
ションを起動し任意の速さで動かす事ができる物があります。
それは Custom Slider と呼ばれます。
以下に起動方法として、部品画像をクリックする方法と固有の
部品をクリックする方法を紹介します。

4.4.1 部品画像によるアニメ起動
Plane Maker の3Dコックピットに2Dボタンを設定し、ONになっ
た時アニメーションを起動する方法を示します。

(1) Plane Maker の Standard → Panel: 3-D 画面で Instrument List 
(右図)から but_command_slider.png を選び、計器盤に貼り付

けます。(詳細手順は 3.6 項参照)
分かりにくいですが、この操作の順番に Custom slider の番号

は昇順に N の値が割り当てられます。何番目の設定がどのア
ニメを起動するか覚えて置かねばなりません。

(2) Plane Maker の Standard → Viewpoint メニューの Sliders タブ

で、#1 の Dataref 欄に

　　sim/cockpit2/switches/custom_slider_on[0]
を指定しその上の□にチェックを入れます。☑はこのスライ
ダーが下記の Dataref を使う事を宣言するものです。

time 欄にアニメ実行時間を指定します。

この設定行は#1 から昇順に取ること。(下図) 

注　Dataref の ...custom_slider_on[0]の追番は昇順で、設定行#1 から順に記載するので、

Dataref の追番と設定行#番号はズレます。

(3) 動かす対象オブジェクトには以下の様にアニメーション設定します。            

 Dataref sim/flightmodel2/misc/custom_slider_ratio[0] 

Frame 番号 値 オブジェクト位置

0 0 スライダーが Off の時の位置   

1 1 スライダーが On の時の位置 

Dataref 末尾の [0] の値は起動する...custom_slider_on[0] に合わせます。

参考　Plane Maker の Panel: 3-d 画面で計器盤を表示している時、Alt キーを押下すると
当該スイッチに設定行番号が表示されます。
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4.4.2 固有の部品によるアニメ起動
操縦席にある部品をクリックしてアニメーションを起動する事ができます。例えば車輪
出し入れのアニメの場合以下を使います。(4.5.1 項)
起動用：　　　sim/cockpit2/controls/gear_handle_down
アニメ動作用：sim/flightmodel2/gear/deploy_ratio[1]　　(1 番の車輪の場合)

汎用の Custom Slider の場合は以下の Dataref をペアで使います。

起動用：　　　sim/cockpit2/switches/custom_slider_on[N]
アニメ動作用：sim/flightmodel2/misc/custom_slider_ratio[N]

N の値は Custom slider の番号で最大 24 まで使えます。起動用 Dataref が On (1.0) になる

とその Custom slider の Dataref 値が増加し、再度起動用 Dataref が On になるとその

Dataref 値は減少します。その増加(減少)の時間は Plane Makerで設定します。
以下に設定方法を示します。

(1) Plane Maker の Standard → Viewpoint メニューの Sliders タブで、#0 の Dataref 欄に

sim/cockpit2/switches/custom_slider_on[0] を指定し、その上の□にチェックを入れます。

time 欄にその Custom slider が 0 → 1 にスライドする時間 (つまりアニメーションする

時間) を指定します。☑はこのスライダーが一般の Dataref を使う事を宣言するもの
です。                                                                     

  

                                                                               

注 Custom slider 番号が 4.4.1 項の様にシステムで自動的に取られた場合は、何番の

Custom slider が空いているか分かりません。その様な時は N=24 から降順に取る
事が推奨されています。

(2) 動かしたいオブジェクトに以下の様に目的のアニメーションを設定します。(4 項参

照)

 Dataref sim/flightmodel2/misc/custom_slider_ratio[0]

Frame 番号 値 オブジェクト位置                       

0 0 スライダーが Off の時の位置   

1 1 スライダーが On の時の位置 

   

                                                            

                                                                               

                                                                               

(3) アニメを起動するオブジェクト(操作レバー等) を作成し、そのオブジェクトの

Manipulator に以下の様に設定します。

Type:         マウス操作の種類を選びます。

Cursor:     その部品上にマウスを置いたときの表示画像

Tooltip:     起動するアニメの説明文(任意)
Dataref:     動作を起動する Dataref  (前項(1)で Plane Maker に指定したもの) (注)
On Value:  起動する時の Dataref 値(注)
Off Value:  起動していない時の Dataref 値(注)

注　Typeの設定内容により異なります。

 

Type が Toggle の場合は、オブジェクトをクリックすると起動用 Dataref が On (1.0) に
なり、その Custom slider の Dataref 値が増加します。再度クリックすると起動用

Dataref が Off (0) になりその動作用 Dataref 値は減少します。
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4.5  設定例                                  

4.5.1 主脚のアニメーション設定
一例として主脚を取り上げます。主脚の上げ下げは、車輪の回転、ダンパーによるタイ
ヤの上下動、オレオの動き、ステーの折り畳み、脚軸の回動、扉の開閉とそれぞれアニ
メーション指定します。

主脚のアニメーションで使う Dataref 値 (.../gear/deploy_ratio[ ]) は
脚上げ時で 0、脚下げ時で 1 となります。従って、Dataref 値が 0
の時 (つまり脚上げ時) を Frame が 0 としてアニメーションを開
始しなければなりません。

基本的に先端部の動きからアニメ設定するのが良いです。今回
は以下の手順でアニメーション設定しました。左右の脚とも同
様に設定します。

(1) 主脚各部の部品を親子孫の関係を付けて Blender で作成しま
す。右図の様になります。

(2) 脚が出た状態で孫部品であるタイヤの回転をアニメーション

します。機体を進行させる方向に 90°回転したのを Frame 1 と

し、90°毎に繰り返す設定にします。

 Dataref sim/flightmodel2/gear/tire_rotation_angle_deg[1] 

Frame 番号 値 オブジェクト位置

0 0 初期状態   

1 90 タイヤを進行方向に 90°回転

Loop Animation every:  90

上記 Dataref は 1 番の脚の場合です。

(3) 脚が出た状態で子部品である主軸先端部の地上と空中での軸

方向撓み (地上で 0.2m のたわみ) をアニメーションします。
またオレオの位置や角度も同時に設定します。

 Dataref sim/flightmodel2/gear/tire_vertical_deflection_mtr[1]

Frame 番号 値 オブジェクト位置

0 0 たわみ無し(脚上げ時)   

1 1.0 たわみ 0.2m (接地時)

Loop Animation every:  0                                                                    

上記 Dataref は 1 番の脚の場合です。

(4) 親部品である主脚の付け根部およびその子部品 (主脚カバー、リンク 1、リンク 2、
タイヤ軸) にアニメーション設定します。Frame 間の動き(角度) が大きいとアニメー
ションを見てステー１やステー２の動きがおかしい事があります。その場合は中間

Frame を増やして、Frame 間の動きの差を小さくする必要あります。今回の例では

Frame 0 → Frame 4 まで五段階に分けてアニメーション設定しました。  

 Dataref sim/flightmodel2/gear/deploy_ratio[1] 

Frame 番号 値 オブジェクト位置

0 0 完全脚上げ状態  

1 0.25

2 0.50

3 0.75

4 1.0 脚完全下げ状態

Loop Animation every:  0     

  上記 Dataref は 1 番の脚の場合です。                                     

　　Frame 4    Frame 3              Frame 2                        Frame 1                        Frame 0   

                                             

                                       

    

(5) 主脚の動作を起動するレバーオブジェクトを作成し、その Manipulator特性に以下を

設定します。(5 項参照)
    Type:          Toggle
    Cursor:      Hand
    Dataref:      sim/cockpit2/controls/gear_handle_down 
    On Value:   1
    Off Value:   0
なお、レバーオブジェクトには脚と連動して動くアニメ設定が必要で、3.6 項の計器

盤と合わせてコックピット OBJ に含めます。
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5.  マニピュレーション設定

マニピュレーションを設定すると、X-Plane は画面上のその部品にマウス操作されたかど

うかを常に把握し、操作が有った時に所定の Dararef 値を出力する事が出来ます。その値
を元に指定された部品のアニメーションが起動します。

注意：マニピュレーションを設定した部品はコックピット OBJ に含まれねばなりません。

注意：マニピュレーションを設定しようとする部品が小さくてマウスクリック困難な場
合は、別部品のオブジェクトを作りそれにマニピューション設定 (5.2.2 項)します。

その場合 Material タブで Draw Linked Objects のチェックを外し非表示にします。

5.1  設定方法                                
(1) 起動のトリガとなるオブジェクトを作り、そのプロパ

ティの Object タブ   の▼X-Plane で Maniurator に
チェックを入れます。

(2) 表示されるメニューの Type:で適用するマウス操作の
タイプを選択し、その下に表示される欄に必要な値
を入れます。

Type:         マウス操作の種類を選びます。

Cursor:     部品上にマウスが来た時の表示アイコン

Tooltip:     起動するアニメの説明文(任意)
Dataref:     動作を起動する Dataref  (Plane Maker に指

定したもの) (注)
On Value:  起動する時の Dataref 値(注)
Off Value:  起動していない時の Dataref 値(注)

　　　　　注　Type の設定内容により異なります。

                                                                                  

  

 

                                          

  

5.2  設定例

5.2.1 クリックしてアニメ起動する例
部品をクリックしてアニメを起動する方法です。

(1) 動かす部品(今回は右図の照準) をクリックし、プロパ

ティ枠の Object タブ   の▼X-Plane で Add Dataref ボタ
ンをクリックし、右
図の様にアニメー
ション設定します。

   

              

                      

                      

(2) アニメーションのト

リガとなる部品 (こ
の例の場合は上と同じ部品) の Maniurator にチェックを入れ上図の様にマニピュ
レーションを設定します。

(3)  Plane Maker の standard → Viewpoint メニューの Sliders タブで、#24 の Dataref 欄にト

リガとなる Dataref (この例の場合 sim/flightmodel2/misc/custom_slider_ratio[2]) を指定

し、その上の□にチェックを入れます。time 欄にそのスライダーがスライドする時

間を指定します。(下図)

上の例は一つの部品にマニピュレーションとアニメーションを設定していますが、別々
の部品にそれぞれを設定してもかまいません。
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5.2.2 クリックしづらい部品の場合
部品が小さい等によりクリックしづらい場合、クリック用に別オブジェクトを被せ、マ
ニピュレーションを設定します。この時、その部品の Material 設定で Draw Linked 
Objects のチェックを外し、見えないけれどマニピュレーション機能だけ持たせる様にし
ます。

注意　マニピュレーションを設定する部品が他の部品の子である場合、その親部品もテ
クスチェが付きません。同様に Draw Linked Objects のチェックを外します。

(1) 例えば右図の様なスイッチの 3D モデルに下表のアニメーションを指
定した物を用意します。

 Dataref sim/cockpit/weapons/bombs_armed

Frame 番号 値 オブジェクト位置

0 0 レバー上(爆弾安全)   

1 1.0 レバー下(爆弾投下可能)

Loop Animation every:  0                                                                    

(2) レバーに被さる様にマニピュレーション用部品(右図)を用意します。
この部品は、

・コックピット OBJ に含める事

・Material設定でDraw Linked Objectsのチェックを外す事

・必要なら元のレバーと同じ動き (アニメーション) を設定する事
・以下の様なマニピュレーションを設定します。
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6.  LOD設定
LOD (Level of Distance)とは、オブジェクト描画中のビデオメモリ負担を軽減する目的で、

設定された距離以遠の描画を省略する事です。LOD は最大 4 種類の設定範囲の中からど

の範囲を LOD するか選択する事で設定されます。各設定範囲の近限界と遠限界は OBJ 
(X-Plane オブジェクト) 毎に設定されます。（6.1 項）

これにより OBJ内で個々の部品がどの LOD 設定範囲を有効にするか選ぶ事ができます。

(6.2 項）

LOD 設定しないと X-Plane は全範囲でその部品を描画します。そのままでも構いません。

注意：コックピット OBJ および Weapon OBJ の部品には LOD を設定出来ません。LOD
を設定するとその部品は描画されなくなります。

6.1  LOD 設定範囲設定                       
Blender 画面の Scene タブ   の中から設定したいレイヤーを開き、▼XPlane から Levels 
of Detail を設定します。

OBJ毎に LOD 設定範囲は最大 4 種類設定され、その子部品毎にどの範囲を表示するか設

定されます。(6.2 項)
以下の例ではあるレイヤーの LOD 範囲の数を 4 とし、各範囲の近限界(Near:)と遠限界

(Far:)を指定しています。単位は m です。
 
                                               

Levels of Detail                                                    
OBJ で扱う LOD 表示範囲を具体的に設定します。

個々の部品がどの LOD 範囲をつかうかは、6.2 項

の LOD:で指定します。                       

 　LODs: LOD を設定する総数(最大 4)を指定。各

LOD 表示範囲の設定欄が現れます。

LOD は表示範囲ごとに定義します。上

から順に、Level of Detail 1→ Level of
Detail 2 → … Level of Detail 4 (最大) の
順で指定します。

Near: LOD 範囲の近限界(単位 m)を指定。

     Far; LOD 範囲の遠限界(単位 m)を指定。

                                               
注意：LOD を設定しなかったら、メッシュは強制

的に one- sided として扱われる様です。     

                                               
Max. Draped LOD:　シーナリでのみ有効です。 

注意：ある表示範囲の遠限界と次の表示範囲の近限界は重なっている必要あります。隙
間があると表示がちらつくことがある様です。

今回のモデルは以下の LOD 設定を採用しました。

表      6  .1    LOD      設定方針例   

LOD 設定範囲 LOD 1 LOD 2 LOD 3 LOD 4

近限界と遠限界 0 ~ 10 m 10 ~ 100 m 100~ 1000 m 1000 ~ 3000 m

1 近くの部品 (Internal 画
面でのみ見る物)  

〇

2 一般部品(小さい物) 〇 〇

3 中小型機、主脚 〇 〇 〇

4 大型機       〇 〇 〇 〇

                                                                             

6.2  部品ごとの LOD 設定
Blender で対象オブジェクトを選択し、Object タブ   で指定します。

▼XPlane

LOD　　事前に 6.1 項で LOD 表示限界の設定します。
当該部品がその設定のどれを適用するかをこ
こで指定します。

チェックボックスの左から、Level of detail 1,
Level of detail 2, Level of detail 3, Level of detail
4 の順となります。
全てにチェックが入っていない場合は全ての

LOD 範囲で表示されます。
 
注意：LOD を近距離に設定すると Plane Maker で表

示されなくなりますがモデリングは問題ありま
せん。Plane Maker で視点を近づけると表示さ
れます。
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7.  各部品の Material 設定

7.1 Material の選択
Blender で作成する部品全てに Material 設定が必要です。Material の設定項目の中には、

一つの OBJ部品全てに同じ設定をしなければならないものがあります。従って Material
設定には分かり易い名前を付けて設定を共有するのが良い様です。一般的には、以下の
様な部品は同じ Material 設定を選ぶことになります。

(1) 機外の部品

Normal Metalness (7.3 項) にチェックを入れ金属表面を表現する事を推奨します。そ

の場合は OBJ 中の部品は全て Normal Metalness が設定されていないとエラーになりま
す。

(2) 機内の部品

Normal Metalness にチェックを入れる必要ありませんが、Specular の Intensity (7.2 項) 
は OBJ の中で統一しなければなりません。

(3) テクスチャを貼らない部品

マニピュレーション検出する部品、鏡像複写の基準となる平面および Camera 
Collision 設定する部品などは描画する必要の無い場合があります。この場合は Draw 
Lincked Objects のチェックを外します(7.3 項)。OBJ内で描画する部品としない部品が
混在するのは問題ありません。

(4) コックピット OBJ の部品

以下の部品はコックピット OBJ に入れなければならないので、全て Part of Cockpit 
Panel (7.3 項) にチェックを入れます。

　・X-Plane が書き込む計器部品
　・マニピュレーション設定する部品

　・Camera Collision 設定する部品

そうしないとエラーになります。これら部品には LOD を設定出来ません。表示され
なくなります。

                                                           

7.2 Material 設定方法
各オブジェクトについて、プロパティ枠の Material タブ    にて以下設定します。飛行
機に関する項目のみ以下に説明します。

(1) Link Material は必ず Data に設定します。
                                          

(2)  新規 Material 設定を作成する場合は Material
名を入力し、必要な各項目を設定をします。

この欄に複数の Material 名がある場合は一番
上のものだけ有効です。従って目標の
Material 名が最上行にくる様順序を入れ替え
る必要あります。

既にある Material 設定を流用する場合は、   

アイコンを押下し採用する Material 名を選択
します。

▼Specular　Intensity: 鏡面反射の強さの設定。

OBJ ではすべての部品が同じ値であ
る必要あります。

▼XPlane
Draw Linked Objects　描画する図形は必ず

チェックを入れます。
ただし、鏡像複写する時のミラー面に
なる平面など、描画しない場合はこの
チェックは外します。              

                                           
Normal Metalness　チェックすると表面に金属

光沢効果が得られます。XP11 以降有
効となりました。この設定を使う場合

は Normal/Specular 画像(8.2 項) を用意
するので面倒ですが、機体外壁部分は
なるべくこの効果を使うべきです。そ
の場合、X-Plane 用オブジェクト内の全ての子オブジェクトもこのチェック
を入れないとエラーになります。
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Blend:                                                                
    Blend Shadow   詳細不明

Alpha Blend　 テクスチャ画像の α チャンエ
ルが使われます。

Alpha Cutoff テクスチャ画像の α チャンネ

ル値が決められた値 (Alpha
Cutoff) と比較され透明/不透明

が分けられます。Alpha Cutoff 
の入力欄(下記)が別に現れま

す。(通常使用せず)

Blend Glass 昼間用画像 (Defaul ファイル) 
の α チャンネルで透明部分を

表現する。（11.0x 以上）
                    
Alpha Cutoff Ratio:    上記の Alha Cutoffを選択し

た場合、α 値(0～1.0) がこの値

以下は 0（完全透明）に設定
する。

                                            
Surface Behavior 

Surface Type:     シーナリーでのみ使います。

      
Camera collision   チェックを入れると視点カメラが当該部品のを通過できない様

になります。
                                                                               

注意：Camera collision を設定する部品は必ず Part Of Cockpit Panel にチェックを

入れ、コックピット OBJ に含めます。また Draw Linked Objects のチェッ
クを外し、見えないようにする事もあります。

注意：Camera collision を定義する図形は、マニピュレーションされた部品の手前
側にあってはいけません。マウスクリック出来なくなります。

Light levels                                                   
Override Light Level   このオブジェクトの夜間の画像が Dataref で制御される場合に

チェック入れます。例えば光がゆっくり点滅する等の効果を出せま
す。

Value 1:　 Dataref の値がこの値以下の時、Override レベルをこの設定値にする

Value 2: Dataref の値がこの値以上の時、Override レベルをこの値にする。 1
以上も設定可能。                                            

Dataref       画像の制御され方を指定する。 Value1 と value2 の間は補間される。

7.3 コックピット部品のMaterial 設定
コックピット OBJ に含める部品は必ず Part Of
Cockpit Panel にチェックを入れます。

さらに Cockpit Region には 1 を指定します。9.2 項

の Cockpits Regions に対応する数字です。        
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8.  テクスチャファイルの準備
テクスチャファイルは GIMP などの画像編集ソフトで作成され、Blender 上で対象部品に

貼り付けられ、指定の場所(1.1 項参照) に配置されているものとします。以下にテクス
チャファイルに必要な条件を記載します。

8.1 必要なテクスチャファイル                              

OBJ (X-Plane 用オブジェクト) の Material 設定により必要なテクスチャファイルが分かれ
ます。
(1) Default ファイル 昼用のテクスチャファイルです。                         

(2) Night ファイル 夜間のテクスチャファイルです。

(3) Normal/Specular ファイル　　機体外表面などで Normal Metalness を指定した部品は、

そのままでは白っぽい色になるので、Normal/Specular ファイ

ルが必須になります。作り方は 8.2.2 項参照。

機体内部など Normal Metalness を設定しない場合は、必要な
場合のみ通常の法線マップを使います。                   

テクスチャタイプ  
Material 設定

Normal Metalness あり
(外表面にある部品が対象)

Normal Metalness なし

Default: 必須 必須

Night: 場合による 場合による

Normal/Specular 必須 (8.2.2 項参照) 不要

テクスチャファイルは以下の条件が必要です。
・引用できるテクスチャファイルは一個のOBJにつき一個の事
・画像の縦横画素数は1024x1024 1012x2048のように2の階乗である事 
・コックピット OBJ の場合ファイル名称は、

　　(機体を区別する名称) + _cockpit_texture.png
　ただし(機体を区別する名称) とは.acf ファイルで使用したファイル名のこと。 

上記ファイルをどの OBJで使うかは 9.1 項で指定されます。                         

                                                                

8.2 Normal/Specular 作成                    
Normal/Specular ファイルは、法線マップ (Norma Map)と呼ばれるファイルから作られま

す。法線マップとは画像の濃淡の変化を面の傾斜に見立て、その傾斜面の法線を RGB 画

像で表現した画像です。X-Plane ではこの画像を使って、元の画像の黒い部分を凹部に、
また白い部分を凸部に見える様表現します。ディフォルトでこの様になります。

X-Plane 11 からは法線マップは拡張され、Normal Metalness を設定すれば、機体表面の反
射を金属のように表現する事が可能となりました。

8.2.1 法線マップと PBR レンダリング
(1) 法線マップについて

法線マップは専用プラグインを使って自動的に作成されます
(8.2.2 項の手順参照)。最初に法線マップが出来る過程の概念を
以下に説明します。

例えば右図のような画像の場合、各画素の明るさ (白を 256,、
黒を 0 とする) を Z 軸で図形で表すと下図の様な形状になりま
す。

各画素の法線ベクトルの、
X 成分 (Xn = -1 ~ 1) を R チャンネル値(0 ~ 255)に、Y
成分 (Yn = -1 ~ 1)を G チャンネル値(0 ~ 255)に、Z 成

分 (Zn = 0.5 ~ 1) を B チャンネル値(0 ~ 255)に、 に変
換します。

以上の RGB チャンネルを合成したものが法線マップです。

従って、画面真上から Y 軸を上に見て濃度の法線が左上に向くほど緑色に、法線が

右下に向くほど赤、法線が真上に向く(濃度の変化が少ない) ほど青色に見えます。

従来の X-Plane (Normal Metalness の設定なし) では以上の法線マップを使って機体表
面の凹凸を表現しました。ただしこのままでは機体の反射などうまく表現できませ
ん。
法線ベクトルの長さ 1 であるので、Z 座標成分 (G チャンネル)の情報がは無くても凹

凸表現には問題ありません。そこで B チャンネルを別の目的に使う手法(PBR)が考え
られました。
                                                                    

(2) PBR (Physical Based Rendering) について

X-Plane  11 から Normal Metalness の設定が可能となり、法線マップの B チャンネルお

よび A チャンネルを以下の様に使うこと出来ます。

・B チャンネル 各画素の反射率の程度、0 の時黒色(反射率小)、256 の時白色(反射率

大)となる。

・A チャンネル 各画素の鏡面の程度、0 の時梨地面、256 の時鏡面となる。          

A/B チャンネルの効果の例は以下のサイトが参考になります。

           https://sites.google.com/view/xpdc/general/texture
この設定により、機体表面の金属的な質感を表現出来るようになりました。このような
レンダリング方式は PBR と呼ばれています。これらチャンネルはもはや色の概念は無く
なり、出来上がりイメージが湧きにくいですが、仕上がり品質は良好です。 
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(3) Normal Metalness 設定の実例

Normal Metalness を設定しなければ従来 X-Plane の様な画質になります。

Normal Metalness を設定して、Normal/Specular
画像を設定しなければ右図のようになりまし
た。色は白っぽくなりました。

Normal Metalness を設定して、Default 画像(昼
用画像)を法線マップに変換し、そのまま

Normal/Specular 画像に使ったら右図のように
なりました。
色は黒過ぎて、表面が鏡面過ぎる画像になり
ました。

Normal Metalness を設定して、

Default 画像(昼用画像)を法線マッ
プに変換し、

　　B チャンネル値を 10％減衰

　　A チャンネル値を 35％減衰
の処理をしたら、ほぼ良好な色の
濃さと表面の鏡面が得られました。

主翼表面の凹凸は、法線マップに
ソリッドノイズを被せた効果です。
(8.2.2 項参照)

  

 

                                        

8.2.2 Normal / Specular の作成方法
以下の手順で作成します。

(1) 次の方法で法線マップ作成プラグインを GIMP にアドオンします。

GIMP を使う事としているので、GIMP normalmap というプラグイ
ンを使います。以下からダウンロードしておきます。

　　 https://czpanel.com/lecture/gimp/plugin/gimp-normalmap-plugin/
以下に右図のような画像をサンプルに手順を説明します。この方法
が正しいのか分かりませんが筆者はこの方法で艦攻`流星`を製作し
ました。                                                    

(2) 次の方法でテクスチャ画像にソリッドノイズを被せます。
第二次大戦中は機体表面のアルミ板が薄い為、機体表面に凹凸が現れています。そ
れを表現する為に以下の様にテクスチャにソリッドノイズを重ねました。最近の機
体は表面が平滑なので、(2)項の手順は全て省いても良いようです。

①　GIMP で上記 png ファイルを開き。そのレイヤーの上に新しいレイヤーを透明度

50%で作成します。

➁　フィルタ→下塗り→ノイズ→ソリッドノイズを選択します。現れた小画面で X 
Size と Y Size を最大の 16 にします。OK を押し、ソリッドノイズのレイヤーを

作ります。ソリッドノイズは強めが良い様です。X-Plane で表示してみて凹凸感
が少ないようであれば、このソリッドノイズのコントラストを強調して再度トラ
イします。

③　ソリッドノイズレイヤーと元の画像を重ねて png ファイルで保
存します。右図の様な画像が出来上がります。

(3) 次の方法で法線マップを作ります。

GIMP で上記 png ファイルを開き、フィルター → カラーマッピ

ング → Normalmap メニューを選択し、別画面が出るので OK を
押下します。右図の様な画像が出来ます。
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(4) 次の方法で法線マップを RGBA の各チャンネルに分けます。
色 → 色要素 → チャンネル分解のメニューをクリックします。現れる画面で色モ

デル欄で RGBA を選択しｓ、OK をクリックします。

 

                 

新しい画像でチャンネル分解さ
れた画像が作られます。

(5) 次の方法で B チャンネル(青チャンネル)の値を 10%下げます。

レイヤー表示枠(画面右下)で B チャンネルのみを表示し入力

可能とします。消しゴムの不透明度を 10%にして画像全面に
消しゴムを施します。

                                 

(8) 次の方法で A チャンネル(アルファチャンネル) の値を 35%
下げます。

レイヤー表示枠(画面右下)で A チャンネルのみを表示し入

力可能とします。消しゴムの不透明度を 35%にして画像全
面に消しゴムを施します。

(9) 次の方法で RGBA チャンネルを合成します。

RGBA すべてのレイヤを表示し (目のマークをクリックし)
画像を青みがかった色にします。
色 → 色要素 → チャンネル合成メニューを選び、現れる

小画面で 色モデル に RGBA を選びます。元の法線マッ
プ画像が修正されたものに置き換わります。この画像を
Normal/Specular ファイルとして所定の場所に保存します。
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9.  OBJと機体データファイル作成

9.1  機体の OBJ 作成
機体部品の Blender ファイルとその貼付け画像が完了したら、OBJ (X-Plane 用オブジェ
クトファイル) を作成します。各レイヤ毎に OBJ が作成されます。

注意：レイヤ内の部品全てに Material 設定してあること。

注意：レイヤ内の部品の Material 設定は、設定項目によっては異なるものが 1 つの OBJ
に混在するとエラーになる場合があります。Material 設定は整理して Material 名
を付け、類似部品間は設定を共有する事を推奨します。

(1) Blender で作成したオブジェクトを OBJ(X-Plane 用オブジェクト)に変換するのに必要

な設定をします。Blender のプロパティ枠 Scene タブ  　 の中から対象 OBJ のレイヤ

を選択し▼XPlane にて必要な項目を設定します(下図)。なお、この画面を出すため

には最初だけ Add X-Plane layers ボタンを押下する必要あります。
                                                                             
X-Plane Version: 最新のバージョンに設

定します。
                                     
Export Mode: 変換する対象の事で、

必ず Layer を選択しま
す。

                                     
Compile Normal-Textures　　詳細不明

Name: OBJ 名称を指定します。

XPlane2Blenderはこの OBJ 名
称を使って OBJ を作ります。

Type: 
Instanced Scenery Object　シーナリの

場合のみ使用

Scenery Object　シーナリでのみ使用

Cockpit　　コックピット OBJ の場合

に指定します。X-Plane が
表示する計器を表示した
りマウス操作を検出する
場合に選択します。

Aircraft (Part)　 機体の部品の場合こちらを選びます。

Textures OBJ に以下の手順で貼り付ける画像を指定します。OBJに対する画像
貼付け場所はBlender上で指定され、その画像は指定の場所(1.1項参
照) に配置されているものとします。(8項参照)

(1) Blender プロパティ枠 Scene タブ   の中の▼XPlane から対象レイヤ
を開きます。

ただし最初に X-Plane レイヤを作る場合は、Add X-Plane layers ボ
タンを押下す必要あります。                                  

(2) Textures 枠の Autodetect Textures のチェックを外し、テクスチャ画
像のルートパスを入力します。                                

Default:      昼用テクスチャ画像のルートパス

Night:          夜用テクスチャ画像のルートパス

                                     
Normal / Specular: 　凹凸用テクスチャのルートパス

注意：画像の縦横画素数は1024x1024 1012x2048の様に2の階乗である事

注意：テクスチャ画像を貼付け先の OBJ 同じフォルダに収納すると、画像ファイ
ル名の前に // を加えるだけで済み、指定が楽になります。(前頁図参照) 

(2) Blender の Render Layers タブ　　で OBJ を作るレイヤー
のみを選択します。レイヤ番号の配列順は以下の通り。

 1  2  3  4  5   6  7  8  9 10
11 12 13 14 15  16 17 18 19 20

(3) 以上の設定が完了したら Blender ファイルを保存します。

その後対象OBJを表示したまま Blender の File → Export → X-Plane Object メニュー

を選択し、OBJ の保存先を指定します。

最後に Export X-Plane Object ボタンを押します。OBJ (.obj) が作成されます。      
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9.2 コックピットOBJ 作成
コックピットOBJを作成する場合は以下の設定が必要なので注意が必要です。

(1) Blender の Scene タブ  　 を開き、コックピット部品を収納したレイヤを選択し以下
の設定をします。

Name: (機体識別名) + _cockpit を指定します。

(機体識別名) とは機体データファイル(.acf)で使った名称です。

Type:                  Cockpit を選択します。

Default: 昼用のテクスチャ画像です。以下の名称を指定します。

// +(機体識別名) + _cockpit

Night: 夜用のテクスチャ画像です。設定する場合は以下の名称を指定します。

// +(機体識別名) + _cockpit_night.png

Normal/Specular　通常指定しません。

Cockpits Regions:に 1 を設定します。

Left: 画像エリアの左端です。0 を
入れます。

Top: 画像エリアの上端です。0 を
入れます。

Width: 画像エリアの幅。テクスチャ

画像サイズの幅が 2 の何乗か
を入力します。今回の場合は

1024 なので 10 を入れます。

Hight: 画像エリアの高さです。今回
の場合は同上の値を入れます。

         

                        

              

(2) 9.1 項の(2)を参照し、コクピットオブジェクトのレイヤーのみ選択します。

(3) 9.1 項の(3)を参照し、OBJ (.obj) をが作成します。

9.3  機体データファイル(.acf)作成
Plane Maker により当該機体のフライトモデル (.acf ファイル) を事前に作成して置きま

す。以下、Plane Maker で作ったモデルを非表示にし(飛行特性はそのまま使用)、代わり

に Bender で作成した機体を使用するように Plane Makerで以下の設定します。 

(1) Plane Maker で当該機体(B7A_Ryusei.acf)を開きます。Expert → Invisible Parts メ
ニューをクリックします。OBJ(X-Plane オブジェクト)と置き換える部品にチェック

入れます。Plane Maker で作成したその部品はを非表示になります。

(2) Standard → Misc Objects メニューをクリックします。画面左下の Add ボタン(次ペー

ジ図)を押します。行が追加されます。

(3)  OBJ 選択ボタン(次ページ図)を押し、OBJ のある場所を指定し、追加する OBJ を選択

します。その OBJ 名称がボタンの右側に表示されます。lighting など OBJ 作成の条件
が有るので必要な条件を設定します。

(4) 機体データファイルの作成

File → Save [Ctrl-s]メニューをクリックし、上書き保存します
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   Lighting     Outside 外部の光を主に受ける部品に選択

                   Inside　 内部の光を主に受ける部品に選択

                   Glass (Outside) 機体外部の透明部品の場合に選択

                   Glass (Inside) 機体内部の透明部品の場合に選択

Shadow Mode                None 透明な物とか影を付けない場合

　　　　　       Interior Only　機内で見る部品に影を付ける場合

Exterior Only　機外のものに影を着け、機内の物には付けな

　　　　　　　い場合                          　

All Views　　　機体内外の物に影を付ける場合

No Prefill　　そのオブジェクトで隠れるシーナリも描きます。

Prefill そのオブジェクトで隠れる雲やシーナリの描画が省略されます。X-
Plane は操縦席から見た画像が表示されるのが多いので、操縦席内壁は
シーナリを隠す部分が大きいので、この設定の効果が大きい。アニメ
された部品、複雑な部品や透明な部品はこの設定すべきでない。

Prefill Only 常に Prefill 実施                                                 

hi-res テクスチャの解像度を下げないで画像の通りにします。操縦者が近く

で見る部品（操縦席内部や計器盤）は hi res を指定します。

Wreckage 機体が壊れた時に表示するオブジェクトにチェックする。

use LOD 5 項の設定を有効にする場合はチェック入れる。チェックを入れない
と全ての距離範囲でオブジェクトが描かれます。

dim LIT 機体を照明するランプが日中の場合は明るくなり過ぎない様にします。

Int Cockpit 機内視点でのみ見える操縦席部品の場合に選択。

Ext Cockpit 機外視点でのみ見える操縦席部品の場合に選択。

Kill Dataref ここに記載する Dataref(プラグンで作られる)の値が 0 の時のみ、この

オブジェクトが描画されます。Dataref 欄が空欄であればこのオブジェ

クトは常に描かれます。Kill Dataref を使えば GPU と CPU両方の処理

時間が節約されます。アニメーションの Hide を使って場合は、見た目

同じで GPU 時間は節約出来ますが、CPU 時間は節約されません。    

注意：コックピット OBJ( ..._cockpit.obj) の場合、Int Cockpit と Ext Cockpit の両方共に

にチェック入れないと X-Plane (V11.4) はクラッシュします。逆に両方または片方
だけチェックするのは問題有りません。
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OBJ 選択ボタン

オブジェクトの原点を機
体先端に統一しているの
で、全て 0 となります。

オブジェクトは、機体本体と同じ動き
をするのでこのままの設定です。

ADD ボタン


